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Chapter 1
New Features 2022.2

This document provides a high-level summary of this release.

It includes a summary of the new features in this release, any authorization code changes 
required, any major installation changes, and any transitioning issues you should be aware of 
before installing. Additionally, any last minute issues found in the final stages of testing are 
included.

For a detailed list of new features, refer to the Tanner Tools Release Notes available from the 
InfoHub or on Support Center.

L-Edit  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

Library Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Revision Control  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

S-Edit. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Tanner Designer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

L-Edit 
The following new features are available in this release of the L-Edit tool.

Layer Operations

A new Layer Operations menu in the Layer Palette lets you easily select or delete objects on the 
layers selected in the Layer Palette. Instances containing the specified layers can also be 
selected. Deletion of objects on the specified layers can be done in the active cell, in the 
hierarchy of the active cell, or in all cells. 

Selection Manager

A Selection Manager in L-Edit lets you easily see the list of objects selected, highlight the 
selected objects on layout, remove objects from the selection list, and delete selected objects 
from layout. 

Library/Cell/View Name Presentation

The format of the Library/Cell/View name when referencing a view is now customizable. You 
can choose from four preset choices on the Setup Application > Format dialog box, or you can 
customize your own format with a small tcl function. 
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GDS Import/Export Warnings 

The number of warnings issues by GDS/OASIS import and export is now limited to 100 
warnings of each type. This can significantly improve performance for designs with large 
numbers of warnings.

New Label Selectability Button

A button to toggle label selectabilty has been added under the Layer Palette, along with the 
previous buttons to toggle selectability of instances, vias, and ports.

Select Under Point Command

A new command Edit > Select > Select Under Point selects all objects under a point with a 
single mouse click.

Performance Improvement Loading Libraries With Many Cellviews

Performance populating the list of cellviews in a library in the Library Navigator when opening 
a lib.defs file can now be improved by creating an index of the cellviews in the library. This can 
produce significant performance improvements for very large libraries on a network drive. The 
script for creating the index file is called mkindex.py and is located in the LinuxUtils folder. 
This feature is suitable for static libraries in which the list of views do not change

Calibre RealTime Runset Support

The Calibre Realtime integration from L-Edit now supports the runset feature. To use the runset 
feature in Calibre RealTime, you need to upgrade to Calibre 2022.2_15 or later.

Add Wire Section to Push Wires Aside 

The Draw > Add Wire Section command now lets you draw a rectangle to push selected wires 
aside to make room for other objects. The wires wrap around the rectangle maintaining their 
spacing as the rectangle is resized.

Run Custom Scripts on Tool Startup/Shutdown and Design Open/Close

Running a custom TCL script on program startup/shutdown, and database open/close is now 
supported in all tools. Scripts may be located in a “scripts” folder in the database folder, in 
%AppData%\Tanner EDA (Windows), $HOME/.tanner/config (Linux), or in a folder given by 
an environment variable $TANNER_TCL_AUTOLOAD_DIR.

Separation of User Preferences and Technology 

User preferences and technology have been separated. User preferences are now saved in the 
registry and not in technology, and modifying user preferences will no longer mark the tech as 
modified. Settings in the Setup Design dialog box are user preferences. In the Setup Technology 
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dialog box, the Rule Aware Layout and Node Highlighting tabs also contain user preferences 
inside a groupbox labeled Settings.

Library Manager 
The following new features are available in this release of the Library Manager tool.

Run Custom Scripts on Tool Startup/Shutdown and Design Open/Close

Running a custom TCL script on program startup/shutdown, and database open/close is now 
supported in all tools. Scripts may be located in a “scripts” folder in the database folder, in 
%AppData%\Tanner EDA (Windows), $HOME/.tanner/config (Linux), or in a folder given by 
an environment variable $TANNER_TCL_AUTOLOAD_DIR.

Hierarchical Copy

Enhanced hierarchical copy for cells and library to copy the whole cells.

Performance Improvements

Improved performance opening lib.defs in Library Manager.

Show Instantiated Views 

Library Manager is now able to show which views are instantiated using the library report, cell 
report, and view report tcl commands.

Revision Control
The following new features are available in Revision Control in this release.

TCL Callback Interface 

A TCL Callback interface has been developed for custom Version Control Integration.

S-Edit 
The following new features are available in this release of the S-Edit tool.

Schematic P-Cells

Schematic P-Cells are now supported. For example, parameters on a symbol can be used to 
update the number of pins on the symbol, and the underlying schematic will be automatically 
generated.
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L-Corner Wire Drawing Mode

L-Corner drawing mode draws an L-shaped wire from the last vertex. L-Corner mode now 
preserves the direction of the segment as you move the mouse away from a vertex, allowing you 
to easily connect two points with a minimum of clicks. You can press the L key to flip the 
orientation of the L while drawing the wire.

Corner Setup Enhancements

Corner setup now allows multiple variables with the same library name. These are netlisted in 
the same Alter.

Library/Cell/View Name Presentation

The format of the Library/Cell/View name when referencing a view is now customizable. You 
can choose from four preset choices on the Setup > Preferences > Format page, or you can 
customize your own format with a small tcl function.

Parasitic PEX/xACT Netlist Import

S-Edit is now able to import PEX/xAct netlist views and create a schematic view containing 
both the intentional and parasitic devices. A cellmap file is used to provide the mapping to the 
correct symbols. Device properties from the netlist are applied .

Add Voltage, Current, and Differential Probe from Results page

Three new buttons are added to the Setup Simulation > Results page for adding voltage, 
current, and differential probe signals to the signals table. Pressing these buttons allows addition 
of multiple signals at one time by clicking on each signal on the schematic. 

Setup Number of Significant Digits Displayed

The number of significant digits or decimals displayed in annotations on schematic views can 
now be controlled using new number format settings on Setup > Preferences > Format.

Performance Improvement Loading Libraries With Many Cellviews

Performance populating the list of cellviews in a library in the Library Navigator when opening 
a lib.defs file can now be improved by creating an index file of the cellviews in the library. This 
can produce significant performance improvements for very large libraries on a network drive. 
The script for creating the index file is called mkindex.py and is located in the LinuxUtils folder. 
This feature is suitable for static libraries in which the list of views do not change.

TCL Function to Populate Testbenches on Creation

A TCL function "tanner_new_testbench_proc" is now run, if defined, when a new testbench is 
created (from the <New> item in the Setup Simulation “Testbench” droplist) that allows the 
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testbench to be prepopulated with desired setup. The TCL function is passed FOUR arguments: 
lib cell view testbench, and is documented on the “New Testbench” dialog box.

Differential Probing

Reference probe on the Simulation Toolbar has been changed to differential probe. In 
differential probe mode, the user clicks 2 nets for each probe created. The first net is the positive 
net and the second click is the negative net.

TCL Command to Populate Corners Setup 

A new command "workspace setactive -corners" makes it easier to populate the corners matrix. 
This command clears out existing corner data, and then accepts a single Tcl argument that is a 
"list of lists". The first list is the list of corner names; subsequent lists each define a single row. 
For example:

workspace setactive -corners {
  {c1 c2 c3}
  {library {c:\tmp\test.lib} FF SS {FS SF}}
  {variable V1 1.0 1.1 1.2}
  {variable V2 {} 0:10:100}
  {temperature T1 30 40 50}
}

Easy Selection of Parameters in Corners Setup

A new dropdown on a parameter variable in the Corners page allows easy selection of 
parameters defined in the Parameters page.

EZWave Plot Options Setup

A Plot Options dialog box is now available via the context menu on the Plot Options column in 
the Results page in Setup Simulation. This dialog box provides a user interface to set various 
Plot Options such as titles, axis formats, line styles, and so forth.

Results Page Editing Enhancements

Holding the Ctrl Key down when pressing the Add button in the Setup Simulation > Results 
page will add a new entry at the end of the table. Without holding the Ctrl key, the new entry is 
added below the currently selected row.

Run Custom Scripts on Tool Startup/Shutdown and Design Open/Close

Running a custom TCL script on program startup/shutdown, and database open/close is now 
supported in all tools. Scripts may be located in a “scripts” folder in the database folder, in 
%AppData%\Tanner EDA (Windows),$HOME/.tanner/config (Linux), or in a folder given by 
an environment variable $TANNER_TCL_AUTOLOAD_DIR.
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Technology Reference for New Library 

The New Library command now requests a technology reference.

Performance Improvements 

Performance of loading very large schematic views such as parasitic views or digital 
synthesized views is improved.

Tanner Designer
The following new features are available in this release of the Tanner Designer tool.

Run Custom Scripts on Tool Startup/Shutdown and Design Open/Close

Running a custom TCL script on program startup/shutdown, and database open/close is now 
supported in all tools. Scripts may be located in a “scripts” folder in the database folder, in 
%AppData%\Tanner EDA (Windows), $HOME/.tanner/config (Linux), or in a folder given by 
an environment variable $TANNER_TCL_AUTOLOAD_DIR.
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Chapter 2
Installation and Authorization Codes

The installation process consists of installing the MGLS (Mentor Graphics Licensing System) 
software, the license file, and the product software and documentation.

Authorization Codes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Version  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Licensing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Authorization Codes 
No changes to authorization codes are required for this release. You may request your existing 
authorization codes by opening a non-technical Service Request on Support Center.

For additional information on licensing, refer to the Licensing Mentor Graphics Software 
manual.

Version 
Tanner Tools is no longer supported on Windows 7, starting January 2020. This coincides with 
the end-of-life date for Microsoft Windows 7. Tanner Tools 2016.2 is no longer supported as of 
Jan 2020.

Licensing 
Tanner Tools are currently installed with FlexNet licensing version v11.14.1.3/MGLS version 
2018_1.

If problems are encountered users install the latest version of FlexNet PCLS licensing software 
from Support Center.

https://support.mentor.com/
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Chapter 3
Support and General Information

Application and online help is available from technical support and documentation.

Global Customer Support and Success . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Broken Links in PDF Documentation - MG595892 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Global Customer Support and Success
A support contract with Siemens Digital Industries Software is a valuable investment in your 
organization’s success. With a support contract, you have 24/7 access to the comprehensive and 
personalized Support Center portal.

Support Center features an extensive knowledge base to quickly troubleshoot issues by product 
and version. You can also download the latest releases, access the most up-to-date 
documentation, and submit a support case through a streamlined process.

https://support.sw.siemens.com

If your site is under a current support contract, but you do not have a Support Center login, 
register here:

https://support.sw.siemens.com/register

Broken Links in PDF Documentation - 
MG595892 

Due to enhanced security restrictions in web browser plug-ins used for viewing PDF files, 
manual-to-manual links do not resolve. Clicking a link may result in no action, or it may load 
the title page of the current PDF manual (instead of the target in the intended PDF manual).

The unresolved link behavior occurs in all web browsers on Windows® and Linux® platforms. 
This behavior does not affect the links in the table of contents, the index, or the links to content 
within the same PDF manual. Because of this behavior, the navigational experience of PDF 
manuals is compromised. However, PDF is still ideal for printing. Mentor Graphics continues to 
monitor the situation and will adapt to future industry developments. For a fully-functional 
navigational experience, use the HTML manuals.

https://support.sw.siemens.com
https://support.sw.siemens.com/register
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Third-Party Information

Details on open source and third-party software that may be included with this product are available in the
<your_software_installation_location>/legal directory.
Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.
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